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Subsection 1

2.1 Data Entry in SPSS
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1. Data Entry Preparation

@ The SPSS Data Editor has two views:
© Data View — displays the dataset in spreadsheet form.
@ Variable View — used to define variables, types, labels, and formats.
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1. Data Entry Preparation

€@ Untitied! [DataSeto] - M $PSS Statistcs Data Editor 4
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This is the Data
View of the Data
Editor window.

Typically, in
psychology each
row contains
data from one
participant and
each column is a
variable.

The Data View
tab is highlighted.
This tells you that
you are looking at
the Data View.

IBM SPSS Statistics Processor is ready
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Click the Variable
View tab to change
to the Variable View
(below).



1. Data Entry Preparation

3 Untitled! [DataSet0] - 1M SPSS Statistics Data Editor - o x
Ele EGt View Data Iransform Analze Graphs  Utiities Etensions Window Help

SEe | <= lh

This is the Variable

Name Type | Mign | N View of the Data
; J Editor window.
3
4
5
6
7
e
9
10
1

Note that the
Variable View tab
is highlighted to
indicate you are in
the Variable View.

[ (1B SPSS Statistics Processoris ready| | [UnicodeON| | | |
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2. Defining Variables (in Variable View)

Before entering data, it is essential to define your variables properly:

@ Choose clear variable names.
@ Decide on coding schemes for categorical variables.
@ Select appropriate formats (numeric, string, date, etc.).
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2. Defining Variables (in Variable View)

Variable Name

@ Must start with a letter.

@ No spaces allowed (use underscore _ instead).
o Example: age, gender, income_level.

@ *Untitled [DataSet0) - IBM SPSS Statistics Data Editor

Eile Eot  View Data Jransform Analze Graphs Utities Exensions Window  Help

ST L EEN fE 0N Y EIT

Name Type Width  Decimals Label Values
X Numeric 8 2

T

Missing Columns Align Measure Role

1 None None 8 M Right Unknown N Input
2
3

We have named the first variable ‘Sex’, because we
are going to use this variable to code the sex of our
participants. Note SPSS has added default values
for the other columns. We will explain these next.
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2. Defining Variables (in Variable View)

Variable Type

@ Choose the correct type (numeric, string, date, etc.).

@ Using numeric codes for categories is preferable (e.g., 1 = Male, 2
= Female) instead of using string variables like "M" and "F".

o Avoid string variables whenever possible, as they complicate

analysis.
€8 “Untitied! [DataSetd] - 1BM SPSS Statistics Data Editor Clle in the cell and
Sile Edt View Data Iransform  Analyze 94: Usities  Extensions  Window  Help . .
then click on this
) u [ Yot
ERT LY I Y EFEFYY button to call up the
Name Type ‘Width Decimals Label Values Missing Columns Variable Type dlalogue

1 Sex Numeric 8 2 None None 8 Ll

box (see below).
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2. Defining Variables (in Variable View)

Variable Width & Decimals

@ Width defines how many characters are stored.
@ Decimals sets the number of decimal places.
@ Defaults are usually sufficient unless specific formatting is required.

Q *Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor You can Change the variable
File Edit View Data TIransform Analyze Graphs lites  Exten Width and number of

’j H @ na — E %% Decimals places by changing

3 l these values. However, this

Name Type Width /6ecima,s Label only alters the look of the table,
8 2 not the way the values are

stored or used in calculations.

Sex | Numeric

allw|in|-
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2. Defining Variables (in Variable View)

Variable Labels
o Add descriptive labels (e.g., Respondent Age in Years).
@ These appear in SPSS output and help in interpretation.

@ Not mandatory, but highly recommended for clarity.
Note that we have used a variable label. This

isn’t essential here but is often useful.

@ *Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor
Data Transform Analyze  Graphs

'%e% B~ BhIE 0 E,

Type Width | Decimals Values

1 Sex Numeric 8 2 Sex uf Partlcnpanl None
2

Ullities  Exdensions Window  Helj

w

To add value labels, click in the Values cell,
then click on this button. This will call up
the Value Labels dialogue box (see below).

10/34
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2. Defining Variables (in Variable View)
Value Labels

@ Assign meaning to numeric codes.
@ Example: 1 = Male, 2 = Female.

If you are using value labels, enter the
value into the Value box, then enter the
label for this value into the Label box.

R Value Labels X
\alile 'abala ;I'her(; gl;(r:]k on |the|A;(|jtbuttr:on
- 0 a is value label to the
-k Spetng..) list of labels for this variable.
Label:| Female] ] Repeat these steps to add
{1.00 = "Male” additional values and labels.
When you have added all
the values and labels for the
variable, click on the OK
[E button to close the dialogue
box and return to the Variable
View table.
V.
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2. Defining Variables (in Variable View)
Missing Values

@ Define user-missing codes (e.g., 99 = missing).
Note that we can see the value labels we added in
the previous step.

Q *Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utilities Extensions | Window Help

e H. W <« l&%@ - EEEYD

Name |  Type Width | Deci Label ¥ Values ~ Missing |
Sex Numeric 8 2 Sex of Participant {1.00, Male}.. |None | 8

Click on this button in the Missing cell to call up
the Missing Values dialogue box (see below).
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2. Defining Variables (in Variable View)

Measure

@ This is used to specify the level of measurement for the variable.
@ SPSS offers three options: Nominal, Ordinal and Scale

Select the Scale option for
variables measured using

= O % either an interval or ratio scale.
@ / Select the Ordinal option for
- : variables measured using an
sing | Columns Align I Measur Role | ——
8 = Right Scale > Input =
& Scale /
ofl Ordinal Select the Nominal option for
& Nominal <] nominal variables (e.g. ‘sex’ or

‘group’).
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2. Defining Variables (in Variable View)
Role

@ The final column Role is recent addition to SPSS and is intended to
help users select appropriate analyses.

Input is the default option
and is used for independent
variables and predictor

= O X variables.
] Target is used for dependent
i variables.
Imns | Align ] Measure Role /|
= Right & Scale N Input /v - Both is used for variables that
v Input ¥ / can have either role.
@ Target‘/
@ BOth | —] . q
e None is used for variables that
@© None X
! have no predefined role.
EH Partition
= Split =

i For now don’t use Partition or
Split (see text).
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3. Entering Data (in Data View)

@ We will enter the data from a simple study in which we have recorded
each participant's

> Sex (coded as 1 = Male, 2 = Female and 3 = Other),

> Age (in years) and the

» MemoryScore (number of words recalled from a list of 20) of each
participant.

@ In addition we have assigned each participant an ID number.

@ Before we can enter these data, we need to define the four variables
to be used (see the previous section for details of how to define a
variable)

Md Rasel Biswas 2 Data Entry and Import 15/34



3. Entering Data (in Data View)

Defining variables in Variable View

We have set up four variables. All are We have specified a missing value for
numeric variables. We have left the each variable. For example, we used
width settings at their default values. 9 as the missing value for Sex — but

we could have used any value that
could not otherwise occur.

(& “Chpt 2_1.5a [DataSet1] - [BM 5PSS Statistics Data Editor

Eile Edt View [Data Transform  Analge Graphs  Ubliies Extensions Window Hefp

n

SHE R -~ BLAE K B 106

[V hame Type Width  Decimals Label Values | Y Missing | Columns Align Measure Role
1 D Numeric 8 None 939 8 3 Right & Nominal N Input
2 Sex Numenc 8 {1.00, Male}... 9.00 8 W Right &b Nominal “ Input
3 Age Numeric 8 Age in years None 999.00 8 W Right & Scale “w Input
4 MemoryScore Numeric 3 Mem /20 None 99.00 3 3 Right & Scale N Input
Although not necessary, we have We have specified the measure for each variable. ID and
set the number of Decimals to Sex are Nominal as the values only represent a label. Age
zero for the variable ID. and MemoryScore are set to Scale. Note the different

icons associated with these settings. These icons will
appear next to the variable name in the Data View.
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3. Entering Data (in Data View)

@ Each row = one observation (e.g., one respondent).
@ Each column = one variable (e.g., Sex, Age, Score).

This shows that a value is
currently being entered for the
fifth participant in the column
‘MemoryScore’.

&) *Chpt 2_1.sav [DataSet1] - IBM SPSS Stafistics Data Editor

File Edit View Data nsform  Analyze Graphs  Utiliies E
= H L‘g{]/m [i]/ ~ 08 e = This value represents the
— memory score for the fifth
BRSSO 1200 participant. As you type in
&ID & Sex & Age | & MemoryScore the number, it appears both
1 1 23.00 12.00 here and in the cell that was
2 2 999.00 8.00 highlighted.
3 3 25.00 Ei]
4 4 18.00 9.00
5 5 21.00 This participant declined to
6 tell us their age so we have

entered ‘999, which is the
missing value we assigned
for this variable.

This icon next to the variable name serves as a reminder of the
Measure (the level of measurement) we specified. The three
circles represent Nominal, and the ruler represents Scale.
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The Value Labels Button

|#] *Chpt 2_1.sav [DataSet1] - IBM SPSS Statistics Data Editor
F_ile Edit View Dala Transform Analgze Graphs Utilties Extensions Window Help

SHE B o= B0 8 BE 19«

\5 MemoryScore |17 00
| & &Sex | & Age | & MemonyScore], var | var | [ var | var
1| 1 1.00 23.00 12.00
2 2 1.00 99.00 8.00
3 3 3.00 25.00 11.00
4 4 2.00 18.00 9.00
—— SR T E—1

Click on the Value Labels button to toggle between
displaying the values entered (as shown here) and the
associated labels (see below).
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The Value Labels Button

&) *Chpt 2_1.sav [DataSet1] - IBM SPSS Statistics Data Editor
Eile Edit View Data Transform Analyze Graphs Utilities Exensions Window Help

=1- 1= . o B M ﬁ@]uﬁ"@m

[5: sex
| &1 &Sex | P Age & MemoryScore,  var | var | \var var |
1 1 Male 23.00 12.00
2 2 Male 99.00 8.00
| 3 Other 25.00 11.00
4 4 Female 18.00 9.00
B | 5 21.00 17.00
6 |
7
8
a

Once the Value Labels button
is depressed, the values in the
Sex variable are replaced by
the associated labels.

In this mode, if you double-
click in a cell, SPSS will offer
you a drop-down list of the
value labels associated with
this variable.
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4. Saving a Data File

|#] "Chpt 2_1.sav [DataSet1] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs

New
Open
Import Data
(38 Close
k4 save
Save As
k= Save All D3ta
Export
_'® Mark File Read Of

Revertto Saved File
Wi Rename Dataset
Display Data File Information
[ Cache Data
Collect Variable Information
]
@ Switch Server.
Repository
|4, Print Preview

SPSS uses the file name ‘Untitled1’ for a file that has not
been saved. If there are two unsaved data files open at
the same time, the second will be called ‘Untitled2’.

Once you save the file, your new name will appear here.
We have called this file ‘Chpt2_1’. SPSS adds the default
suffix ‘.sav’ to indicate a data file.

Click on Save to save the data file. If the file has been
saved previously, it will be resaved using the same name.
If not, you will be prompted for a name.

Click on Save As if the file has been saved before but you
now want to save it under a different name.

Click on Save All Data if you have more than one file
open, and you want to save them all.
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5. Opening a Data File

2. Click on the File menu.
G DatakfitryExercisel.sav [DataSet1] - IBM SPSS Statistics Data Editor

File” Edit View Data TIransform Analze Graphs Utilities Exter 3. Select Open.
e el Vil
Qren ' | Opata. 4. Choose Data.
Import Data > InternetData |
&a se Ctri+F4 @W-- h \
M save Ctri+S a 00
@ Qutput.. %
) SRRAS @ Script.. 00
i Save Ay Data 18.00 9.00
Bxpot * b10o 17.00
|"® Mark File Read Only
Revertto Save e
Wil Rename Dataset .
Display Data File Information »
EH Cache Data...
Collect Variable Information
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6. Data Entry Exercise

RODENTS IN SPACE: A SIMPLE MEMORY EXPERIMENT

Twenty-one first-year undergraduates participated in a simple memory
experiment designed to investigate the effect of a mnemonic strategy on
memory for paired words. The participants were randomly divided into two
groups. All participants were given two minutes to memorise a list of 20
words presented in pairs. All the participants were told to memorise the
words, but those in the mnemonic instruction group were advised to try to
form a mental image to link the two words in a pair (e.g. for the word pair
Rocket - Hamster, a participant might imagine a small furry rodent being
launched into space). The participants in the other group, the
non-mnemonic group, were not given this instruction. After learning the
words for two minutes, the participants were then required to complete
some simple mental arithmetic problems for two minutes. Finally, all
participants tried to recall the words in any order. The number of words
correctly recalled was recorded. The data are summarised below.
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6. Data Entry Exercise

Memory scores (out of 20) for participants in the mnemonic instruction
group:

20,18,14,18,17,11, 20, 18, 20, 19, 20

Memory scores (out of 20) for participants in the non-mnemonic group:

10,20,12,9, 14, 15, 16, 14, 19, 12
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6. Data Entry Exercise

Using these data, attempt to do the following:

@ Set up an SPSS data file to record these data. Give appropriate
names to the variables you are using.

@ Apply value and variable labels where appropriate and specify the
level of measurement and the missing values for each variable.

© Enter and check the data, then save the file using an appropriate file
name.

@ Ensure that you can reopen the file.

© Compare the data file you have constructed to the one illustrated in
Section 7.
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6. Data Entry Exercise

@ *DatakntryExindGrps.sav [DataSet2] - IBM SPSS Statistics Data Editor
File Edt View Data Iransform Analze Graphs  Util

SHE B e B

We have called this variable ‘MemoryScore’. Being
lazy, we have left the variable width as 8 with 2 decimal
places, but we have increased the Columns setting to
10 so that the variable name fits. This isn't essential.

We have used the name ‘Condition’ for this variable.
Because it is a nominal variable, we have used value
labels to show that the value 1 indicates the participant
was in the mnemonic condition, and the value 2

that they were in the non-mnemonic condition (see
screenshot of the Value Labels dialogue box below).
We have set Decimals to O (to display no decimal
places), but this isn’t essential.

For this screenshot, we did not have the Value Labels
button depressed; if it is depressed on your system,
then your screen will show the value labels rather than
the values.

16.00 We have included a variable called ‘ParticipantiD’,

14.00 which gives each participant a number. This is not

19.00 essential but is good practice; we will explain why
later. We have also increased the column width so the
variable name fits in.

1
1
1
1
1
1
1
1
1
1
2
2
2
2
2
2
2
2
2
2
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6. Data Entry Exercise
This is the Variable View of our data file. Note that we have set
Missing values for each variable and have set the Measure for
each. Although not critical, we have also set some Decimals to
zero and have changed the Columns for some of these variables.

Ele EG View Data Transtrm Analze Graphs  Utiles Etensions Window Help

EFEY SR T XN EFPFT)
o T

Name Type Width | Decimals Label Values
1 ParticipantiD  Numeric 8 0 None 999 10 ;W Right
2 Condtion  Numeric 8 0 {1, Mnemon... 9 8 M Right & Nominal o Input
3 |MemoryScore Numeric 8 2 Mem /20 None 99.00 1" M Right & Scale . Input
-
R Value Labels X

Value Labels
J

Label: [
1="Mnemonic™
Add |[2= 'Non-mnemomc\
= e —
Change These are the value labels
we used for the variable
‘Condition’.

Remove
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Subsection 2

2.2 Data Import
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Importing Excel Data

@ Suppose we have an Excel file vote.x1sx (download) containing
data like the following:

Evoteﬁfr@@

File Edit View Insert Format

Q & @~ 100% + © Viewo

Al - ID
A B Cc D
1 Gender  Party
2 1 M 2
3 2 M 1
4 3 F 3
5 4 M 2
6 5 F 2
7
8
a
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Importing Excel Data
Steps

© Open SPSS and go to File > Open > Data.

@ A new window will appear asking you to select the File Type.
© Choose Excel (.xIs, .xlIsx) from the drop-down menu.

@ Browse to the folder where the file is saved and select your file.
© Click Open.

O A new window will appear as shown below:

4 Opening Excel Data w g

E:\Data fileswote.xIsx

[¥/:Read variable names from the first row of data

Worksheet: \Sheen [A1:C6] h ‘

Range: | l

Maximum width for string columns:
|
L (Lox_J(cancel [ hetp |
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Importing Excel Data

Selecting Data from the File

@ In the import dialog box:
Select the appropriate worksheet (if the Excel file has multiple sheets).
By default, SPSS imports the entire sheet.
To import only a portion of the data, specify a Range (e.g., A1:B6).
Example: To import only the variables ID and Gender from the first 6
rows, enter A1:B6 in the Range field.
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Importing Excel Data

Practice

@ Try importing the following files:
hs0.sav (download)
hs0.x1s (download)

Reflection Question

@ What are the advantages of importing a .sav file instead of an
Excel file?
(Hint: Consider variable names, labels, formats, and missing value
handling.)
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Importing Other Data (Stata, SAS, etc.)

@ Besides Excel, SPSS can directly open datasets created in other

statistical software such as:
> Stata (.dta)
» SAS (.sas7bdat)
» SPSS portable files (.por)

This feature is useful when collaborating with researchers who use different
software.
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Importing Other Data (Stata, SAS, etc.)

General Steps

@ Go to File > Open > Data.

@ From the File Type drop-down list, choose the relevant format (e.g.,
Stata, SAS).

© Browse to the folder where the dataset is saved.

@ Select the file and click Open.

© The dataset will appear in SPSS with variable names, labels, and
some metadata preserved.
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Importing Other Data (Stata, SAS, etc.)

Practice

e Try importing a dataset from another software, e.g.,
bdhs2014.dta (download) from Stata or
airline.sas7bdat (download) from SAS.

Summary

o Excel files: Good for raw data entry and sharing, but limited in
metadata.

o Stata / SAS files: Retain more metadata and are useful for
collaboration.

e SPSS (.sav): Native format with full compatibility (best for
long-term work).
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